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Introduction

1.1 What is Smart Design®?

This Smart Design allows you to design and print the images, photos, texts and barcodes on the
plastic cards (ISO CR-80) or encode on the magnetic stripe.

When you run Smart Design, you can see a blank screen. This is the 54mm x 86mm card size, the
same as ISO CR-80.

=} = Smart Design - Design Sample. csd o @ =

| I Enew File
=

LIOOIN = &
LN

=2
Align
Draning

FFFFF

tttttt
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<Figure 1> The first screen of Smart Design

1.2 System Requirements
This Smart Design is provided with Smart ID Card Printer. This can be used only with Smart ID Card
Printer supplied by IDP Corp., Ltd. To operate this program, IDP Card Printer driver should be
installed.
For the stable operation, Windows 2000/XP/VISTA and 7, Pentium 1GHz with 256MB of RAM or

higher, 100 MB free hard disk space or higher systems are recommended.

1.3 Copyright
This program is not for sale. It is only for the customers of Smart ID Card Printer. No part of this
program may be reproduced and reused by any way without the permission or the prior written
agreement of IDP Corp., Ltd. We have no liability for any problem through the dissemination. IDP

Corp,. Ltd. All rights reserved.



2 Program start

2.1 Execute Program

2.1.1 From Window’s “Start” menu

Click Start menu > All Programs > Smart > SmartDesign

2.1.2 From the shortcut icon created on Desktop background

2.2 Open the card design file

2.2.1Using “Open” command in Home tab

Click Open in Home tab and open the design file(*.csd).

2.2.2Using “Open” command in File tab
Click File tab, click Open and

open the design file(*.csd).

2.2.3Using “Shortcut key”

Press Ctrl+O to open.

2.2.4Using “Recent File”

Click File tab, click recent File.

You can open the design file from the list.

E
ﬂ Haome Drawing Et J ©6 = pea—
[E) New File
4l &= open

Save ) A A A A o
= Print S —
File _ Fo = ==

(a) Using icon in Ribbon Bar (b) File open dialog (c) Using Recent File

<Figure 2> File Open




2.3 Save the card design file

2.3.1Using “Save” command in Home tab

Click Save in Home tab

2.3.2Using “Save” command in File tab
Click File tab and click Save

2.3.3Using “Shortcut key”

Press Ctrl+S to save.

=k -
ﬂ Home Drawing Ei o e
E Mew File =
. e | PR — ||
- = Open E
— : A A A A | -
£ o . 2,
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" IR —

(a) Using Save icon in Ribbon Bar (b) File Save Dialog
<Figure 3> File Save

2.4 Quit Smart Design

Click File tab, click Exit or click the “Exit” icon on right top of the program.

3 Screen Components

When you run Smart Design, you can see the program as below.

3.1 Ribbon bar

Ribbon bar consists of 7 tabs.

3.1.1Home tab
H

eme  Drawing  Edt  Vien  Opton  Hep
: = = N —
[ New File D \ - J_‘_‘ I Obje oy Q |1—r‘ @, Y
Ll = open = E = = L7 Object Borde e ) e | [
B T . e
File Font Draing Panel Invert Page
3.1.1.1 Save

H Save the design file. File format is .csd.



3.1.1.2 New

= Make a new card design.

3.1.1.3 Open
=1

—— Open the design file.

3.1.1.4 Print

s
™ Print the design file.

Printer

Mame;

Status: Feady

Type: IDP SHMART-50 Card Printer

where:  USBOOM

Cornment: [ Prirtt ta file

Frint range Copies

[OF1] Mumber of copies: |S__I

<Figure 4> Printer Select Dialog

Be cautious that it can be printed with only “IDP SMART-50 Card Printer”, so select a

correct printer name. If you click the properties, the detail setting dialog box will be

displayed.

& IDP SMART-50 Card Printer Document Properties

Lapout E-Paper.-"Hlbbon.v‘F'rmtlng Side/Media | Laminator

Orientation

Fage Order

() Front to Back
() Back to Frort

<Figure 5> SMART-50 Printer Document Properties
Even though the layout direction’s setting is wrong, it is adjusted automatically to the

designed direction. Click OK to save and exit from the detail setting dialog box. Click OK

to print.




3.1.1.5 Font & Barcode list
7| [Code3sil:Y Select the font type or the barcode type.

You can see all possible font types in Windows or all barcode lists supported in this

program.

3.1.1.6 Font Size

12 Set the font size of text object or barcode object.

3.1.1.7 Bold

A

press “Ctrl” key with “B” key to make font bold.

Make a bold font. It is activated when the text object is selected. Click the icon or

3.1.1.8 ltalic

A

italic effect, click the icon or press “Ctrl” with “I” key.

Make an italic font. It is activated when the text object is selected. To make an

3.1.1.9 Underline

— Underline a font. It is activated when the text object is selected. To make an

underline effect, click the icon or press “Ctrl” with “U” key.

3.1.1.10 Font Color

mmmm Set the font color of the text object or the barcode color of the barcode object.
If click the left side of icon, the color is applied. If press the right downside arrow, you
can see the color table as below. You can select the desired color to apply to the text

object or barcode object.
!TY:

Theme Colors

Standard Colors
HE EEEEE
1) Other Color...

<Figure 6> Color Picker Popup

To apply other color which is not shown in color table, click “Other color”.



Basic colors:

ErEErEEE
| IEn il § |
| gaey § i § |
EfAEEEEN
AN EEEEEN

LCustom colors:

[ W MW 1
Huge: Bed: EI
SrrTrrres b o]
Define Custom Colars »» Colort5lid Lum: IE Blue: E

[ Add to Custom Colars ]

<Figure 7> Select Other Color

Select the specific color you want and click “OK” to apply. The icon’s color will be

changed.

3.1.1.11

3.1.1.12 Align Center
E Text is aligned on the center.
3.1.1.13 Align Right
E Text is aligned on the right side.
3.1.1.14 Justify
E Text is aligned on the same distance between the characters.
3.1.1.15 Align Top
— Text is aligned on the top side.
3.1.1.16 Align Middle

Align Left

Text is aligned on the left side.

Text is aligned on the middle.



3.1.1.17 Align Bottom

= Text is aligned on the bottom side.

3.1.1.18 Rectangle

Draw a rectangle. If you select this icon, the cursor will be changed to t+ shape.

The object is set as color panel.

3.1.1.19 Rounded Rectangle

[:] Draw a rounded rectangle. If you select this icon, the cursor will be changed to +

shape. The object is set as color panel.

3.1.1.20 Ellipse

O Draw an oval. If you select this icon, the cursor will be changed to + shape. The

object is set as color panel.

3.1.1.21 Line

R

shape. The object is set as color panel.

Draw a straight line. If you select this icon, the cursor will be changed to +

3.1.1.22 Text

T Make a text box. Input text when text input dialog box is open. The object is set

as black panel.

3.1.1.23 Image

m Insert an image. Select the image when the image selecting dialog box is open.

The object is set as color panel.

3.1.1.24 1D Barcode

”“"l”l‘ Make a barcode. Input data when data input dialog box is open. The object is set

as black panel. You can change the data using “Revise” as below after click the right

button of the mouse.



|ﬂ (I

Cut(x) ; .

C ) .
__________________________ opy(C) -

Order{o) r

Align 3

Ratate »

Revise(R)

Input Figld({F) 3

Set Az DefaultiD)
Properties(F

Input Data

Input data to text’barcode hox,

<Figure 8> Revise Data

3.1.1.25 2D Barcode
Iilb!@
- Make a 2D barcode. The method of data input is same as barcode.

3.1.1.26 Align

=
I‘— Click the Align button, popup menu is displayed as below.

Order

‘-Ea Move to Top
g Move to Front
4 Move toBack
83 move to Bottom

Position
|12 Aign v
| Sk Rotate 3

<Figure 9> Alignh Popup Menu

3.1.1.27 Align - Move to Top

LI-'IE] Move the selected object to top.

<Figure 10> Move the selected object to top

8



3.1.1.28 Align - Move to Front

[% Move the selected object to one step up.

<Figure 11> Move the selected object to one step up

3.1.1.29 Align - Move to Back

% Move the selected object to one step down.

<Figure 12> Move the selected object to one step down

3.1.1.30 Align - Move to Bottom

% Move the selected object to bottom.

<Figure 13> Move the selected object to bottom

3.1.1.31 Align — Align - Left Align
|
|=
*+= Align the selected objects to the left of standard object.

3.1.1.32 Align — Align - Right Align
|

=
—"I Align the selected objects to the right of standard object.

9



3.1.1.33

T

3.1.1.34

3.1.1.35

3.1.1.36

5

3.1.1.37

i

3.1.1.38

e

=

3.1.1.39

Align — Align - Top Align

Align the selected objects to the top of standard object.

Align — Align - Bottom Align

Align the selected objects to the bottom of standard object.

Align — Align - Align Same Width

Align the distance of the selected objects in horizontally same distance.

Align — Align - Align Same Height

Align the distance of the selected objects in vertically same distance.

Align — Align - Horizontal Center Align

Move the selected objects to the horizontal center.

Align — Align - Vertical Center Align

Move the selected objects to the vertical center.

Align — Rotate - 90° Clockwise Rotate

l-l-
—‘a' Rotate the selected objects 90 degree clockwise.

3.1.1.40
y

Align — Rotate - 90° Counterclockwise Rotate

—= Rotate the selected objects 90 degree counterclockwise

3.1.1.41

4k

Align — Rotate - Flip Horizontally

Reverse the selected objects right and left.

10



<Figure 14> Image Object — Flip Horizontally

3.1.1.42 Align — Rotate - Flip Vertically

=l
"M Reverse the selected objects upside down.

<Figure 15> Image Object — Flip Vertically

3.1.1.43 Object Fill

OrobjectFil ~ got the background color of the selected object.

Click the left part of the button to apply the selected color.

If click the right downside arrow, you can see the color table as below.
[ obgectFill] |
Theme Colors
H EEENEN

standard Colors
HR EEEER
Mot Fill
1) Other Color...

<Figure 16> Color Popup for Object Fill

You can make background color transparent, click Not Fill.

If there is no desired color, click Other Color... for the specific color.

11



B aszic colors:

Pt Nl BB
Il B
EEEEEE NN
EfEEEEEN
EEEEEEE N

BT

LCustom colors:
[ or W M Hue 150 Hed_El‘
O OO r i
Sat EI Green; EI
Define Custom Colors 3> ColorlSolid Lum: EI Blue: EI
[ Add to Custom Colars ]

<Figure 17> Select Other Color

Click OK to apply it to background color after select the color.

3.1.1.44 Object Border

L7 ObjectBerder | = gt the outline color of the selected object.

Click the left part of the button to apply the selected color.

If you click the downside arrow of the icon, the color table will be displayed.

L7 Object Border |~

Theme Colors |
H  EEEEEEN

I -. |
ey
I I i ﬁ ﬁ
|
| |

| Standard Colors i
| |

Mo Line
48 Other Color...
Line Style 3

Line Width »

<Figure 18> Color Popup for Object Border
You can make outline color transparent, click Not Fill.

If there is no desired color, click Other Color... for the specific color.

B aszic colors:

Pt Nl BB
Il B
EEEEEE NN
EfEEEEEN

LCustom colors:

[ or W M 1
Huge: Bed: EI
SrrTrrres b o]
Define Custom Colors 3> ColorlSolid Lum: EI Blue: EI

[ Add to Custom Colars ]

<Figure 19> Select Other Color

Click OK to apply it to background color after select the color.

12



Line Style changes the outline type of the object.
If you move the cursor on the menu, the outline type list will be displayed. Select the

outline type.

Line Width changes the outline thickness of the object.
If you move the cursor on the menu, the outline thickness list will be displayed. Select

the outline thickness.

3.1.1.45 Set as Color Panel

/ Set as color panel for the selected object. If the installed ribbon is not color ribbon,

this icon will not be activated. When the object is set as color panel, the blue color is

applied to the object.

<Figure 20> Set as Color Panel

3.1.1.46 Set as Black Panel

M Set as black panel for the selected object. Text and barcode are set as black
panel at default. The background, outline and font will be changed to gray color. For the
image object, the dithering effect will be applied. If the object is set as black panel, the

square of outline will be black color.

<Figure 21> Set as Black Panel

13



3.1.1.47 Set as Overlay Panel

/ If you click this icon after select the object, overlay will not be applied to that
object.
The Image, text and barcode are not overlaid if this icon is clicked.

When the object is set as overlay panel, the square of outline will be changed to gray

color.
<Figure 22> Overlay Panel Editing
3.1.1.48 Set as Rewritable Panel

/ If you click this icon after selecting the object, rewrite function will be applied to
that object. How to use re-writable panel is same as overlay panel. Re-writable panel will
appear if the printer is re-writable printer instead of overlay panel. If it is not re-writable
printer, it is not appeared. The dark area represents that is to be erased on a card. The
bright area represents that is not to be erased on a card. If the whole parts of panel are

dark, the front panel of a card will be erased, then re-written.

3.1.1.49 Set as Fluorescent Panel

/ If you click this icon after select the object, fluorescent will be applied to that

object.

The Image, text and barcode are fluoresced if this icon is clicked.

T e Ry

2olNMARIL . g

‘o o o O a O
G Ber o G e o e i s G e ok ik s i o
[ [ =
= =
D ...... D ...... E

<Figure 23> Flunrescent Panel Editing

14



3.1.1.50 Display Color Panel

m You can see all objects which are set as color panel.

3.1.1.51 Display Black Panel

You can see all objects which are set as black panel.

3.1.1.52 Display Overlay Panel

@ All overlay panels can be seen. The overlaid area will be displayed darker than

not overlaid area.

3.1.1.53 Display Rewritable Panel

@ The object display on the screen is chosen by re-writable panel. If select the re-

writable object display that represents part will be erased by dark. This icon will appear

instead of overlay panel icon if the printer is re-writable printer.

3.1.1.54 Display Fluorescent Panel

E All fluorescent panels can be seen. The fluoresced area will be displayed more

blue printed than not fluoresced area.

3.1.1.55 Invert Overlay Panel

Q Basically, overlay is supplied to all surface of card. In case of the text, drawing

and image object, the contents will not be overlaid. If you want to reverse this, click this
icon. Refer to the below example.

=] (=] =] =] = =

<Figure 24> Overlay Panel Reverse

3.1.1.56 Invert Fluorescent Panel

Q Basically, re-writable panel is set up to clear the front of card. In case of the text,

15



drawing and image object, the contents will not clear in the card. If you want to clear
some part and printing, select “Invert re-writable panel” and select the given object in
area. If select “Invert re-writable”, it will set up to do not clear whole part of card. It will
clear marked text, drawing and image object. This case will apply equally to Fluorescent

panel.

3.1.1.57 Front Page
== This Smart card printer can print the front side and back side. It can be set by the

printer setup. The icon will be activated when the related side is under designing.

3.1.1.58 Back Page

} You can design the back side of the card using this icon. It will be activated when

the printing setup is both-side printing.

3.1.2Drawing Tap

“ Home  Drawng | Edit  View  Opton  Hep @
== == i ELm
==== [J OO \NHET [l 3

Rectangle Elipse Round Line 1Image Text 1D 2D | |= o] TF i ooe
Rectange Barcode

de Sarcode
nt Paragraph Drawing Align

3.1.2.1 Font & Barcode list
Please refer to Chapter 2.1.1.5.

3.1.2.2 Font Size
Please refer to Chapter 2.1.1.6

3.1.2.3 Bold
Please refer to Chapter 2.1.1.7

3.1.2.4 ltalic
Please refer to Chapter 2.1.1.8

3.1.2.5 Underline
Please refer to Chapter 2.1.1.9

3.1.2.6 Font Color
Please refer to Chapter 2.1.1.10
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3.1.2.7 Align Left

Text is aligned on the left side.

3.1.2.8 Align Center

Text is aligned on the center.

3.1.2.9 Align Right

Text is aligned on the right side.

3.1.2.10 Justify

Text is aligned on the same distance between the characters.

3.1.2.11 Align Top

Text is aligned on the top side.

Align Middle

w
RN
N
RN
N

Text is aligned on the middle.

3.1.2.13 Align Bottom

= Text is aligned on the bottom side.

3.1.2.14 Rectangle
Please refer to Chapter 2.1.1.18

3.1.2.15 Rounded Rectangle
Please refer to Chapter 2.1.1.19

3.1.2.16 Ellipse
Please refer to Chapter 2.1.1.20

3.1.2.17 Line
Please refer to Chapter 2.1.1.21
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3.1.2.18 Text
Please refer to Chapter 2.1.1.22

3.1.2.19 Image
Please refer to Chapter 2.1.1.23

3.1.2.20 1D Barcode
Please refer to Chapter 2.1.1.24

3.1.2.21 2D Barcode
Please refer to Chapter 2.1.1.25.

3.1.2.22 Move to Top
Please refer to Chapter 2.1.1.27

3.1.2.23 Move to Front
Please refer to Chapter 2.1.1.28

3.1.2.24 Move to Back
Please refer to Chapter 2.1.1.29

3.1.2.25 Move to Bottom
Please refer to Chapter 2.1.1.30

3.1.2.26 Left Align
Please refer to Chapter 2.1.1.31

3.1.2.27 Right Align
Please refer to Chapter 2.1.1.32

3.1.2.28 Top Align
Please refer to Chapter 2.1.1.33

3.1.2.29 Bottom Align
Please refer to Chapter 2.1.1.34

3.1.2.30 Align Same Width
Please refer to Chapter 2.1.1.35
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3.1.2.31 Align Same Height
Please refer to Chapter 2.1.1.36

3.1.2.32 Vertical Center Align
Please refer to Chapter 2.1.1.38

3.1.2.33 Horizontal Center Align
Please refer to Chapter 2.1.1.37

3.1.2.34 Same Width Adjustment

—
O+ Change the width of the selected objects same as the standard object.

3.1.2.35 Same Height Adjustment

+
@
+...d Change the height of the selected objects same as the standard object.

3.1.2.36 Adjust Same Size

L+ Change the size of selected objects same as the standard object.

3.1.3Edit tab
“ Homi Drawing Edit View Option Help @
et 1 E!N@
==== [ OO \NETIN =
AAA A = = Rectangle Elipsz Round Lne Image Text 1D D | |a ST ok e
- Rectangle Barcode Barcode
Fant Paragraph Drawing Aign
3.1.3.1 Undo

i)

Reverse the last command.

3.1.3.2 Redo

u Reverse the action of the “Undo” .

3.1.3.3 Paste

e

_1 Paste the cut or copied object.
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3.1.3.4 Cut

i' Remove the selection from the design and place it in the clipboard.

3.1.3.5 Copy

—‘|='E| Copy the selected object in the clipboard.

3.1.3.6 Select all

I':E Select all objects in active design.

3.1.3.7 Delete

'—"‘i Delete selected object.

3.1.3.8 Object Properties

-.d-l"l Double-click on the selected object or press Alt+Enter key. A window will appear.
The contents of the object properties depend on the kind of selected object.
To apply background color, line color, line type and line thickness to the new object
created from now on, click the “Set the properties to the new object” .
Object Property 53
| Line 3 Colo [ pos and Sie

Background

Colar f

Line

Type: — =

g 0vmn g

[Set &= Defautt Preview

<Figure 25> Set as basic

In “Position and Size”, “Horizontal” and “Vertical” mean the distance from the left-top to
the object. “Width” and “Height” mean the width and height of the object.
In “Ratio”, “Width” and “Height” are 100% at first because this property lets current

object ratio 100% and can change ratio.
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Checking “Fix the Ratio of Width and Height” keeps the same ratio. If you change the

width, Smart Design would change the height automatically with same rate.

Object Property &|

Pasition and Size

Lett |2642mm |2 Top | 1151mm |2
‘Wicth | 21.08mm |2 Height |1363mm |2
Rotation |0 |-

Scale

wicth [100% |2 Height [100% |2

Use Aspect Ratio

[Set &= Defautt

<Figure 26> Object Properties - Size

In “Content Tab”, the text or barcode can be changed directly.

Object Property. [E Object Property [E
Content | Ling and Calor | Pos and Size | Text Content | Line and Color | Pos and Size || Barcods |
content: | T \ Cartert ;| |
Fip Code |7
[] st &= Defaut Preview [] 5t Az Defaut LM

<Figure 27> Object Properties - Content

“Text Tab” appears when all selected objects are text ones. In “Inside Space”, you can

control the size of spaces between the text and edge line of the text objects.
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Object Property @

ticontent § LN and Color Ros nd Sz
Inner Space
0 Al o (S
Right [034mm |3 Battom [034mm |3
Align
Horizontal | Certer v: Wertical | Miciclle v:
[CIFit to Frame Width
et &z Detautt Preview
<Figure 28> Object Properties - Text
Left Space l Top Space
Bottom Space —m H Right Space

You can set the standard of text position in the frame with “Alignment” function. The

ways of alignment are following.

Horizontal
Top Middle Bottom
< . SMART . S
g. Center ; : . SMART SMART
5 . 2 i
QO e . . 5
Right .  SMART, SMART: © SMART

<Figure 29> Each case of Align in Text Object

“Fit to frame size”
if the text is long enough to over the frame, “ Fit to frame size “ automatically change
the text size and font to fit to do not cut it off. If the text is shorter to fit the frame, it will

automatically increase the size of text.
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"Fit to frame size" OFF "Fit to frame size” OMN
Object Property [z|

[ Line anet Coler | Pos and Size

Ratio
ZoomMethod |Fit Same aswidth v | | Use Aspect el
Horizontal Ratio | 57 “ertical Ratio
Original Wicth | 6773 mm Crigingl Height | 50.80 mm
Rotate | 0° = [CHotizartal Flig
[ ertical Flip
Arrange & Offzet
Horizontal | Center nal vl Wertical | Middle vl
Lett Start [oo0mm | Top Start 483 mm |
ﬁ Find Portr.ai .
Image Effect -
Color Effect | Auto v| [ awuto
Contrast € | 3[s0% |%
Brightness < | ¥la0% |

[Set &= Defautt

<Figure 30> Image Object Properties

In “Image Tab”, we can control the value of the image properties. “Enlargement Method”

in “Ratio” sets the rule of enlargement or decrease image in the frame.

A. Fit same as width
e . The width of image becomes the same as the width
|  of frame maintaining current ratio of width and height

of the original image.

B. Fit same as height
The height of image becomes the same as the height
of frame maintaining current ratio of width and height

of the original image.
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C. Fit size same as box size
The width and height of image become the same as
the width and height of frame. The ratio of the width

and height of the original image is ignored.

D. User Setting

You can set the ratio of the width and height of the

image without consideration of the ratio of image and

frame.

In user setting, “Horizontal Ratio”, “Vertical Ratio” are in active. You can change each
value. If “Use aspect ratio” is checked, width and height will be changed at the same

rate.

“Original Width” and “Original Height” represent the size of the original image. They will

be used for references to change ratio.

You can rotate the image with “Rotate”. The unit for rotation is 90 degrees.

“Horizontal Flip” reverses the image right and left, and “Vertical Flip” turns image upside

down.

Cancel Vertical Flip Check Vertical Flip
i cochios s bacewti ol e el e o :

di4 |euozuoH [goue)
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dij4 |eyuozLioH 308yD

<Figure 31> Image Object - Flip

In “Alignment and Offset”, “Horizontal Alignment” and “Vertical Alignment” set the place

of the image in the frame.

<Figure 32> Image Object - Align

“Image Effect” sets color, contrast and brightness of image
“Color” sets the color of image. “Auto” keeps the original color of image. “Gray” removes

colors in the original image, and changes it gray tone.

“Contrast” controls the contrast light and shade. 50% is the same status as original
image. The rate is available from 0 to 100 percent. You can change the value with scroll

bar or direct entry.
“Brightness” controls the degree of brightness. 50% is the same status as original image.

The rate is available from 0 to 100 percent. You can change the value with scroll bar or

direct entry.
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Cortert | Line and Color | Pos and Size Cortert | Line and Color | Pos and Size
1D Barco — 1D Barco
Type | Code39(1:2) R Type
[ shaw Digit [C]Fit to Frame wicth it to Frar
Crption 1 Option 2 Cition 1 Option 2
2D Barcode 2D Barcode
Type Type | POF 417 v |
Option 1 | Option 2 | | Option 1 [ 1 Il Option2 [0 @
[]5et A= Defautt Ereview []5et A= Defautt Ereview

<Figure 33> Barcode Object Properties

In “Barcode Tab” you can change the properties of barcode objects.
“Type” shows the type of the barcode.

Checking “Show Digit” shows the number at the bottom of the barcode.

T

I

<Figure 34> Barcode Object — Show Digit

If “Fit to Frame size” is checked, it will automatically change the barcode size to fit to

frame size.

3.1.3.9 Contrast Up

. ]|

Contrast up to the selected image object.

3.1.3.10 Sharply Contrast Up

D3

Sharply Contrast up to the selected image object.

3.1.3.11 Contrast Down

Bl

Contrast down to the selected image object.

3.1.3.12 Sharply Contrast Down

i 3

Sharply Contrast down to the selected image object.
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3.1.3.13 Brightness Up
"""!'-T Brightness up to the selected image object.
3.1.3.14 Sharply Brightness Up
* Sharply Brightness up to the selected image object.
3.1.3.15 Brightness Down

x|

Brightness down to the selected image object.

3.1.3.16 Sharply Brightness Down

"i;!‘-i Sharply Brightness down to the selected image object.
3.1.3.17 Zoom In
% Zoomin the image.
3.1.3.18 Sharply Zoom In
L Sharply zoom in the image.
3.1.3.19 Zoom Out

% Zoom out the image.

3.1.3.20 Sharply Zoom Out
L Sharply zoom out the image.
3.1.3.21 Move Left

Move the image to the left direction.

3.1.3.22 Sharply Move Left

Sharply move the image to the left direction.
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3.1.3.23 Move Right

Move the image to the right direction.

3.1.3.24 Sharply Move Right

Sharply move the image to the right direction.

3.1.3.25 Move Up

Move the image to the upper direction.

3.1.3.26 Sharply Move Up

Sharply move the image to the upper direction.

3.1.3.27 Move Down

=l Move the image to the down direction.

3.1.3.28 Sharply Move Down

Sharply move the image to the down direction.

3.1.3.29 Set as Color Panel
Please refer to Chapter 2.1.1.45

3.1.3.30 Set as Black Panel
Please refer to Chapter 2.1.1.46

3.1.3.31 Set as Overlay Panel
Please refer to Chapter 2.1.1.47

3.1.3.32 Set as Rewritable Panel
Please refer to Chapter 2.1.1.48

3.1.3.33 Set as Fluorescent Panel
Please refer to Chapter 2.1.1.49
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3.1.3.34 Invert Overlay Panel
Please refer to Chapter 2.1.1.55

3.1.3.35 Invert Fluorescent Panel

Please refer to Chapter 2.1.1.56

3.1.4View Tap

ﬂ Home  Drawing  Edit  Vien Opton  Help
il Change Ruler Display | (3, Zoom 97 % | (&) 100% Zoom m | | ﬁ nen e J} =y
$#f Change Grid Display 3, Zoom In #i3 Auto Zoom | == -

Display | Display | Display Front | ac
\Color Panel |Black Panel |Overlay Panel Fluorescent Panel page
Pag

loms Conver Status Bar| | (5 Zoom Out
fiew Zoom Panel

3.1.4.1 Change Ruler Display

Select whether the display of Ruler or not.

3.1.4.2 Change Grid Display

3.1.4.3 Convert Status Bar

Select whether the display of Grid dot is shown or not.

L
——— Select whether the status bar is shown or not. Status bar shows the information of

position of mouse cursor and explanation of ribbon bar.

] . Consider all the selected objects as one. Display the starting point in unit of

millimeter.

" . Consider all the selected objects as one. Display the width and height in unit of

millimeter.

L3 Display the current point of mouse cursor in unit of millimeter.

3.1.4.4 Zoom

[
4 Show the card size you input.
3.1.4.5 Zoom In

-
[ |

% Zoom in the card layout.
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3.1.4.6 Zoom Out

A
& Zoom out the card layout.

3.1.4.7 100% Zoom

(L)

Show the original size design.

3.1.4.8 Auto Zoom

¥
e
"E-!- Fit the size of design panel to the window. As the window size changes, the rate

of “Zoon In/Out” will be changed automatically.

3.1.4.9 Display Color Panel

11

You can see all objects which are set as color panel.

3.1.4.10 Display Black Panel

You can see all objects which are set as black panel.

3.1.4.11 Display Overlay Panel

e

not overlaid area.

All overlay panels can be seen. The overlaid area will be displayed darker than

3.1.4.12 Display Rewritable Panel

e

writable object display that represents part will be erased by dark. This icon will appear

The object display on the screen is chosen by re-writable panel. If select the re-

instead of overlay panel icon if the printer is re-writable printer.

3.1.4.13 Display Fluorescent Panel

i

blue printed than not fluoresced area.

All fluorescent panels can be seen. The fluoresced area will be displayed more

3.1.4.14 Front Page

== Please refer to Chapter 2.1.1.57
30



3.1.4.15 Back Page

f“} Please refer to Chapter 2.1.1.58

3.1.50ption Tab

Home  Drawing  Edt  View  Option  Help Q
| 23 Setbackground color —_— =
o e @ R
' = Show badkground image -
Snap ) Input field Magnetic fild | FitBarcode FitText Zoom | Language
wid Edit background image setting setting toFrame toFrame step i
Option Field Config Language

Make cursor move at regular interval.

3.1.5.2 Set background color

bl 1
"2 Select the default color for background. Different colors are available for the front

and back sides.

3.1.5.3 Show background image

= Click to print or not background image.

3.1.5.4 Edit background image

’ﬂ Edit the background image. To change from background image editing mode to

normal editing mode, click “Edit Background Image” again, or click outside of

background image. Only one image for one side is available and it could be printed.

3.1.5.5 Input field setting

This function is used for mass issuing like membership cards, student ID cards

and national ID cards, etc. If you click this button, “Setup Input Field” window is

displayed.
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Setup Input Field =

Field Default Yalue

De=zcription : The akbject which is linked with the field iz

on Front Page B on Color Panel @& Text Ohbject
an Back Page B on Bisck Panel [ Barcode Ohject
B on Overlay Panel = Image Ohject

B on Flucrescert Panel

<Figure 35> Setup Input Field

For further information, please refer to Chapter 4.2.

3.1.5.6 Magnetic field setting

Set the field to encode Magnetic Stripe. If you click this button, “Magnetic Setup”
window is displayed.

Magnetic Setup rg|

Option - Fill Char E @LlowCa (O HighCo

ME1 Track

M3 Track

[ ot use ;|| . |

JIS Track . - . .
iNot use v | |

<Figure 36> Setup Magnetic Fields

For further information, please refer to Chapter 3.1.

3.1.5.7 Fit Barcode to Frame

—

It vou click this button, it will automatically change the barcode size to fit to frame

size.

3.1.5.8 Fit Text to Frame

—
g you click this button, it will automatically change the text size to fit to frame size.
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3.1.5.9 Zoom step

e
= Set the change ratio for the image zoom up / down or image movement.
Image Control Yalue Setup rg|
Scale
No_rmal Grand
5 |1u% !A
Offset
Marmal Grand
|D.68 mm | |1.35 mm |+
| |
[ Ok l [ Cancel l
<Figure 37> Setup Image Control Value
3.1.5.10 Language

hﬁ Change language to use.

3.1.6 Help Tab

3.1.6.1 About

Introduce program version, information etc.

About Smart Design

Smart Design Yersion 1.1.0.0 {20130213)

Copyright IDP Corp, Ltd. Since 2007,

<Figure 38> About Smart Design

3.1.6.2 Help

9 This Smart Design user manual will be open.
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3.1.2File Tab

Smart Design - Untitied o @ %

Front Side Previen

Save print preview of your document to BHP file

Back side Previen

3.1.7.1 New File

Start a new design.

3.1.7.2 Open
=1

—" Open orfind afile.

3.1.7.3 Save

H Save the active file.

3.1.7.4 Save As

A Save the active file with new name.

3.1.7.5 Print Setup

Ay

"Y' Set up the properties for printing such as printing direction, ribbon option, etc.
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Print Setup

Frinter

| oo ]
Status: Feady

Type: IDP SMART-50 Card Printer

Wwhere:  USBOOT

Comment:
Faper Orientation

Size: CRB054.0 % 86.0 mm w | (O Portrait
Source: iAutomaticaII}l Select A | (®) Landscape

<Figure 39> Print Setting
You can change the printing direction to horizontal or vertical.

& IDP SMART-50 Card Printer Document Properties

Layout | Paper/Ribbon/Frinting | Side/Media | Laminator|

Orientation

O.

Fage Order

(® Front to Back
(O Back to Front

[ Ok ][ Cancel ]

<Figure 40> Printing Layout Change

E ew Baos

Co0N
S ETI

S

Registration Card

Nange

ID No. ;#

| Reg. Datel e

Biah biah biaf biah bih biah biah biah bia blah biah bia!
Blah blah bia blah biah biah blah biah blah blah blah bia
Biah blah biah biah biah blah biah biah biah

e o

<Figure 41> Printing Direction Setting

Caution: It may place the active design out of the printing area if you change direction.
Click “Properties” to change the printer driver option.

Click “Advanced” for detail setting of printer. We don’t recommend to use this menu
because it may cause some printing errors. “Horizontal” and “Vertical” mean printing

direction. They carry out the same function of the “Direction” in “Printer Option”
commented just above.
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&% |DP SMART-50 Card Printer Document Properties

| Lapout | F'aper.-"F!ibbon.-"F'rinting. Side/Media | Laminator

Supply Tray
Supply(S): (TR v
Tray(T1 [crao  (54.0mm ¥ 86 omm) v

Rikbaon
Ribbon(RY: | hYMCKO v
Resin(): ;"Enack Ohjects -
Spliti Sy

Printing
Mocle(pd): | Standard v
Speed(S) | Standard v":
Color(C): EICD-I-or g » |
D'rther(_Q): |

[ Ok ] [ Cancel ]

<Figure 42> Paper/Ribbon/Quality Setting

“Paper Tray” is the option for blank cards. “Paper” sets up the way to supply blank cards.

Default value is “Auto.” Smart Card Printer supports only CR-80 size cards.

“Ribbon” sets up the kind of ribbon film in printer.

YMC.K.O

YMC.K.O.K

Half YMC.K.O

K.O

K(mono)

B.O

B.YMC.K.O

YMC.K.F.O

Rewritable

- Ribbons with YMC. K. and O films will be printed on
the front side only.
- Ribbons with YMC, K, and O films will be printed on
the front side while K will be printed on the back side.
- Ribbons with half panel YMC, and full panel K,O films
will be printed on the front side only.

- Ribbons with resin black K, and O films will
be printed on the front side only.
- Ribbons with black K films will be printed on the front
side only.

- Ribbons with dye black B, and O films will be
printed on the front side only.

- Ribbons with dye black B films will be printed
on the front side only.
- The Ribbon consists of adjustable dye Black (B),
Color (YMC), resin Black (K), Overlay (O) film. It is for
one side color printer ribbon.
- The Ribbon consists of Color (YMC), Black (K),
Fluorescent (F), and Overlay (O) films. It is for one side
color printer ribbon

- The printer is rewritable printer. It does not use ribbon.

If you set up this case, It will infect to design front and back, color black, overlay and

36



fluorescent panel set up.

“‘Resin” sets up the way to extract black from the data transmitted to printer.
Black Objects - Black Circle, lines, polygons and black shape can be

extracted and they will be printed by black ribbon

Black Texts - Black text can be extracted and they will be printed by
black ribbon

Black Dots - Black dot can be extracted and they will be printed by
black ribbon

Not Use - No black extraction.

“Split” option decides to separate part of panel to the next page.
Normal - No Split.
Split for Backside - You can set the both sides (Front:YMCO, Back:K) to
save color ribbon(YMCKO, HYMCKO, BYMCKO). It is

only activated while printing both sides option is set.

“Mode” option set printing mode.
Standard. - Default print mode. Print all area.
Partial - Partial print mode. It is printed partially for the print
area only. Printing speed can

be faster than standard mode.

“Speed” option set printing speed and quality.

Standard - Default print mode and best quality setting option of
printing.
High - Fast print mode. This option can be used with only K

and KO ribbon. Printing quality might be lower than
Standard.

“Color” option set up to output color.
Color. - It can print color and black & white data. (“Color” option
is available only with color ribbon.).
Black & White - It can change color data to black & white data. Dither
option set up color data to Black & White.
“Dither” option set up dither method.
There are 3 possible selections, Threshold, Random, and Diffusion Dither. It is

performed with K and KO ribbon only. (Please select “Diffusion Dither” for high quality.)
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& IDP SMART-50 Card Printer Document Properties

.La_l,lout -I.:'aper.-"F!ibbon.-"Printing.| Side/Media ILaminato.r.

Print Side

s [
Front Back

Media: | 1o Cverls Media: | Mo Overla

MaSk: - MaSk: -

[ Ok ] [ Cancel

<Figure 43> Printing Side Setting

“Side” option set up to print backside.

Front - Print only front side. If the ribbon installed is YMCKOK,
the final K is skipped.
Both(Front + Back) - Print both sides. If the ribbon installed is

YMCKO, both sides will be printed with color. If the
ribbon installed is YMCKOK, front side will be printed
with color and back side will be printed with black (K

panel).

“Media” shows the kinds of card used in printing. The card type what you have chosen

will fix the printing area.

Standard - Normal white card. Print the whole card area.

Smart Card - Smart card. Print except smart chip area.

Smart Card[right only] - Smart card. Print the right area from the
smart chip.

ISO MS(Magnetic Stripe) - Magnetic stripe card. Print except 1SO
standard magnetic stripe area.

JIS MS(Magnetic Stripe) - Magnetic stripe card. Print except JIS
standard magnetic stripe area.

Smart Card + ISO MS - Complex card of smart and magnetic stripe
card. Print except smart chip and ISO standard
magnetic stripe area.

Smart Card + JIS MS - Complex card of smart and JIS magnetic
stripe card. Print except smart chip and JIS standard
magnetic stripe area.

No Overlay - It will be printed except overlay.
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User Defined Card - User defines the printing area.

“Edge” has following options.

Not Use

Use

- Don’t print the edge of card. Printing area becomes
slightly smaller.

- Print to the edge of card.

& IDP SMART-50 Card Printer Document Properties

Layout | Paper/Fiibbon/Printing || Side/Media| Laminator |

Laminator Side

Sice | - |
Overlay |Not Use b i

Laminator Contol

Posttion (1300 inch | 0|

Temperature (°C) | 100 |

"Laminator Control" sefting can be modified only in printer property of Contral Panel.
Pleaze change the values at

| "Contral Pane.l - Devices and Printers - Printer - Mouse right button click
| - Printer Property - Printer preferences - Laminatar tap”

[ Ok H Cancel ]

<Figure 44> Laminating Side Setting

If the printer with laminator is connected, “Laminator” tab is displayed.

3.1.7.6 Print

[ _—

E Print the active design file or save Preview of design file to BMP file.

Click Print in File tab, the screen is changed as below.

Recent Fle

Qe

Smart Design - Design Sample.csd

Frone i Prsion

Name ;

IDNo. ;

Reg. Date;

Blah biah biah blah blah biah biah blah biah biah biah bial
Blah biah biah blah biah biah biah blan biah biah blah biat
Blah bl biah blah blah biah biah blah blah

<Figure 45> Print Preview

Print the active design. Click Print button, “Print” window is displayed.
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Printer

Mame;

Status: Feady
Type: IDP SHMART-50 Card Printer
where:  USBOOM

Cornment: [ Prirtt ta file

Frint range Copies

[OF1] Mumber of copies: |i 5__|
F r i_ o {1 _! Iﬂl Iﬂl

<Figure 46> Print — Select Printer
If you make some changes with “Properties”, they are affected only this time. If print
direction is changed in “Properties”, Smart Design will change the design screen at the

same time to prevent print error.

If you click Save Preview button, the preview image on the right section is saved as
BMP file.

3.1.7.7 Recent file

Show the list of design files latest worked. As you click one of them, it would be opened.

I : :
= A smart Design - Untitled = B
|
.i’ Home  Draming  Edit  View  Opton  Help (7]
) HewFile Recent Document
&4 Open
Design Sample. csd &
= save Ciiproject
Wl save ns

= Prink Setup

= Print

Recent File

€ Esit

<Figure 47> Recent File

3.1.7.8 Exit

6 Exit Smart Design.
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3.2 Properties Grid

Properties Grid is “Object Properties” window on the right side of main window. You can see and

modify the properties of selected object.

Bioos Smart Design - Design Sample. csd o & o= Object
ome | Drawng  Edt  Ven  Opi Heb Q@ 4 Base
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<Figure 48> Properties Grid

3.2.1Base Category

Ohiject Properties

4 Base

Page Fraont
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Left 16

Top 216

width 996

Height 420

Rotate o
Border
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Background
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<Figure 49> Properties Grid — Base Category
It shows the information of position and color of object in Base Category. If several objects are
selected and properties are different, the value is not displayed. If the value is modified in

Properties Grid, selected objects are applied.

3.2.1.1 Page

It shows the page where selected object is. Read only.

3.2.1.2 Panel

It shows the panel which selected object is printed on.
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3.2.1.3 Left

It means the distance from the left side of background to the object.

3.2.1.4 Top

It means the distance from the top side of background to the object.

3.2.1.5 Width

It means the width of the object.

3.2.1.6 Height

It means the Height of the object.

3.2.1.7 Rotate
It shows the value of angle of the object. Unit is 90 degrees. You can select the value
among 0, 90, 180, 270 degrees.

3.2.1.8 Border — Style

It shows the line style selected.

3.2.1.9 Border — Width

It shows the line width selected. If Style is “no border”, you can’t change the value.

3.2.1.10 Border — Color

It shows the line color selected. If Style is “no border”, you can’t change the value.

3.2.2 Extended Category — Rounded Rectangle

4 Extended
Corner Round 20

<Figure 50> Properties Grid — Extended Category — Round Rectangle Object

If the selected object is rounded rectangle, it shows the properties of rounded rectangle.

3.2.2.1 Corner Round
It shows the value of edge in Rounded Rectangle. Unit is % and range is 1~100. If the
value if 0, object shape is rectangle. If the value is 100, the short part of width or height

is rounded without line.
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3.2.3 Extended Category — Image

4 Extended
Size

Effect
Auto Effect False
Conkrast o
Brightress [u]

Calor Mode Calor
Zoom & Position
Auto Portrait False
Scaling Fit ko Width of Frame
Width Zoom 44,12 %
Height Zoam 44,12 %
Horz, Align Center
Yert, Align Middle

Inside Left Offset O

Inside Top OFfset 80
Etc.

Corner Round 0

Field

<Figure 51> Properties Grid — Extended Category — Image Object

If the selected object is image, it shows the properties of image.

3.2.3.1 Original Width

It shows the width size of the original image. Read only.

3.2.3.2 Original Height

It shows the height size of the original image. Read only.

3.2.3.3 Auto Effect
It shows whether Auto Effect is applied or not. Auto Effect is the function to adjust the
brightness and contrast in a picture automatically. If the value is true, brightness and

contrast is adjusted properly. Default is false.

3.2.3.4 Contrast
It shows the value of Contrast. Range is -100 ~ 100. Default is 0. If the value is
increased, image color changes primary color. If the value is decreased, image color
changes gray color. If Auto Effect is True, this value is not applied. If you change this

value when Auto Effect is True, the value is applied and Auto Effect changes False.

3.2.3.5 Brightness
It shows the value of Brightness. Range is -255 ~ 255. Default is 0. If the value is
increased, image color changes white. If the value is decreased, image color changes
black. If Auto Effect is True, this value is not applied. If you change this value when Auto

Effect is True, the value is applied and Auto Effect changes False.

3.2.3.6 Color Mode
It shows the mode of color. You can select Color and Grayscale. Default is Color. If Auto
Effect is True, this value is not applied. If you change this value when Auto Effect is True,

the value is applied and Auto Effect changes False.
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3.2.3.7 Auto Portrait
Auto Portrait is the function to find the face in the Image automatically.
If the value is true, the image is focused on the face and adjusted the size and position

properly. Default is false.

3.2.3.8 Scaling
It shows the mode of zoom. If you set Auto Portrait, this value is changed to “User Set”.
Default is “Fit to Width of Frame”. Please refer to Chapter 2.1.4.8 A.

3.2.3.9 Width Zoom

It shows the ratio of width of the image.

3.2.3.10 Height Zoom

It shows the ratio of height of the image.

3.2.3.11 Horz. Align
It shows the mode of Horizontal alignment. If this value is “Left”, image shows from the
left side in the frame. If this value is “Right”, image shows from the right side in the
frame. If this value is “Center”, image shows on the center in the frame. The value of

“Inside Left Offset” depends on this value. Default is Center.

3.2.3.12 Vert. Align
It shows the mode of Vertical alignment. If this value is “Top”, image shows from the top
side in the frame. If this value is “Bottom”, image shows from the bottom in the frame. If
this value is “Middle”, image shows on the middle in the frame. The value of “Inside Top

Offset” depends on this value. Default is Middle.

3.2.3.13 Inside Left Offset

It means the left offset value of start position of image in the frame.

3.2.3.14 Inside Top Offset

It means the top offset value of start position of image in the frame.

3.2.3.15 Corner Round
It shows the value of edge in image. Unit is % and range is 1~100. If the value if 0,
object shape is rectangle. If the value is 100, the short part of width or height is rounded

without line.
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3.2.3.16 Field
It shows the field connected to image. If field is already connected to other text or

barcode when the field is changed, you can’t connect that field.

3.2.4Extended Category — Text

4 Extended
Size

Effect

Auto Effect False
Conkrast o
Brightress [u]
Calor Mode Calor
Zoom & Position
Auto Portrait False
Scaling Fit ko Width of Frame
Width Zoom 44,12 %
Height Zoam 44,12 %
Horz, Align Center
Yert, Align Middle

Inside Left Offset O

Inside Top OFfset 80
Etc.

Corner Round 0

Field

<Figure 52> Properties Grid — Extended Category — Text Object

If the selected object is text, it shows the properties of text.

3.2.4.1 Inner Left Space
It shows the value of inner left space of text in the frame.

For further information, please refer to 2.1.4.8

3.2.4.2 Inner Top Space
It shows the value of inner top space of text in the frame.

For further information, please refer to 2.1.4.8

3.2.4.3 Inner Right Space
It shows the value of inner right space of text in the frame.

For further information, please refer to 2.1.4.8

3.2.4.4 Inner Bottom Space
It shows the value of inner bottom space of text in the frame.

For further information, please refer to 2.1.4.8

3.2.4.5 Horz. Align
It shows the mode of Horizontal alignment. If this value is “Left’, text shows from the left
side in the frame. If this value is “Right”, text shows from the right side in the frame. If
this value is “Center”, text shows on the center in the frame. If this value is “Justify”, text

shows on the same distance between the characters. Default is Center.
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3.2.4.6 Vert. Align
It shows the mode of Vertical alignment. If this value is “Top”, text shows from the top
side in the frame. If this value is “Bottom”, text shows from the bottom in the frame. If

this value is “Middle”, text shows on the middle in the frame. Default is Middle.

3.2.4.7 Auto Size
It shows whether Auto Size is applied or not. If this value is True, text size will

automatically change the size to fit to frame size.

3.2.4.8 Font

It shows the font type, style and size of text.

3.2.4.9 Color

It shows the font color of text.

3.2.4.10 Text

It shows the content of text.

3.2.4.11 Field
It shows the field connected to text. If field is already connected to other image when the

field is changed, you can’t connect that field.

3.2.5Extended Category — Barcode

4 Extended
Size

Effect

Auto Effect False
Conkrast o
Brightress [u]
Calor Mode Calor
Zoom & Position
Auto Portrait False
Scaling Fit ko Width of Frame
Width Zoom 44,12 %
Height Zoam 44,12 %
Horz, Align Center
Yert, Align Middle

Inside Left Offset O

Inside Top OFfset 80
Etc.

Corner Round 0

Field

<Figure 53> Properties Grid — Extended Category — Barcode Object

If the selected object is barcode, it shows the properties of barcode.

3.2.5.1 Type
It shows the type of barcode. If the barcode is 1D type, you can’t change 2D barcode

type. If the barcode is 2D type, you can’t change 1D barcode type.
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3.2.5.2 Size

It shows the size of barcode.

3.2.5.3 Color

It shows the color of barcode.

3.2.5.4 Parameter 1
It shows the value of “option 1” if the barcode type is 2D. It is inactivated if the barcode

type is 1D. This means of value depends on 2D barcode type.

3.2.5.5 Parameter 2
It shows the value of “option 2” if the barcode type is 2D. It is inactivated if the barcode

type is 1D. This means of value depends on 2D barcode type.

3.2.5.6 Show Digit
It shows whether text of barcode is shown or not. It is inactivated if the barcode type is

2D. If the value is changed to “Show”, text is displayed on the bottom of barcode.

3.2.5.7 Auto Size
It shows whether Auto Size is applied or not. If this value is True, barcode size will

automatically change the size to fit to frame size.

3.2.5.8 Start Code
It shows the “Start Code” if the barcode type is Codabar. It is inactivated if the barcode

type is not Codabar.

3.2.5.9 Stop Code
It shows the “Stop Code” if the barcode type is Codabar. It is inactivated if the barcode

type is not Codabar.

3.2.5.10 Data

It shows the data of barcode.

3.2.5.11 Zip Code

It shows the zip code if the barcode type is Maxicode. Max size is 15 characters.
3.2.5.12 Field

It shows the field connected to barcode. If field is already connected to other image

when the field is changed, you can’t connect that field.
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3.3 Drawing Area and Etc.
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<Figure 54> Drawing Area

3.3.1Drawing Area

3.3.1.1 Selection Mode

1. Object selection

1) Direct selection

Move the cursor to the object and click when cursor is changed to K .

2) All selection
Drag the cursor with pressing the left button of the mouse from one point to the

other point. All the objects in this area will be selected.

3) Using “Mouse and Shift key”

Click any object what you want to select with pressing Shift key
¥ Standard object

If you select more than one object, the colored dot outline as below will be the

standard object for the movement, size adjustment and etc.
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<Figure 55> Standard Object

2. Movement of selected object
1) Using “Mouse”
Put cursor on the object which you want to move and press left mouse button
and drag.

2) Using “ Mouse and arrow key”

<Figure 56> Move Objects

3. Size adjustment of the selected object
1) To change the object size, select the related object. & When put the cursor
near the edge of the object, the cursor changes to VA" I . =» Press
the left mouse button and drag the mouse. You can adjust the object size.
2) If you adjust with “Mouse and Shift key”, the width and length will be changed

at the same ratio.

<Figure 57> Resize Objects
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4. Copy the selected object using "Mouse and Keyboard”

To copy the object, drag it with pressing “Ctrl” key.

5. To make round shape
In case the selected objects are rectangle, rounded rectangle or image object,

there will be displayed the yellow diamond mark. This is control point. Put cursor

on diamond, click left mouse button and move it left and right side. The round

shape will be changed.

o

<Figure 58> Change Corner Rounding

3.3.1.2 Drawing Mode
When you select Drawing tool, Mode is changed.

Cursor is changed to —|— .

3.3.2Ruler
It shows the position of selected object and cursor.
You can show and hide “Change Ruler Display” button in View tab.

3.3.3 Status bar

It shows the explanation of ribbon bar in the position of cursor and coordinates of cursor.

] . Consider all the selected objects as one. Display the starting point in unit of

millimeter.
" . Consider all the selected objects as one. Display the width and height in unit of

millimeter.

L3 Display the current point of mouse cursor in unit of millimeter.
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4 Professional Function

4.1 Encode in Magnetic stripe

Enter information in magnetic track.

Magnetic Setup @
Option : Fill Char [a0 |o @LowCo () HighCo

ME1 Track

MS2 Track

Mot Use _v | . . |

M3 Track

E_Not Use v | ; |

JIS Track - - :
Netuse v | | |

<Figure 59> Magnetic stripe Setting

Select one option among “Normal”, “Reverse”, “Bit mode”.

In “Normal” mode, the data is recorded in magnetic stripe along with the card movement direction. It's
usual recording method. In “Reverse” mode, Magnetic stripe is on the front of card so that the data is
recorded in reverse. In “Bit Mode”, magnetic encoding data would be recorded with bit format. To
encode in Bit mode, the user can write specific data and it does not follow the standard of magnetic

writing. Therefore, when the card encoded in Bit mode is read by reader, errors can be occurred.

Magnetic Setup ﬁ]
Optian Fill Char [0 |o @LowCa (O Highta
W51 Track = 2 = = =

| s
| |

M52 Track n - 5
Mot Use _v | |

M3 Track 2
E_Not Use v | |

JIS Track . . :
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<Figure 60> Magnetic Setting - Normal

Select “Normal” in “MS1” track to use magnetic track No.1.

1 5 10 15 20 2= 0

INNNENEEENREEE |

<Figure 61> Input Area of Magnetic Track

The white cells are the spaces for entering data. The blue bar at the bottom is scroll bar.
Black cell in the entering space is the active one. With keyboard, characters are entered in the cell. To

link between magnetic track and field, select areas to enter value of the field by mouse drag and then
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click right button for pop-up menu.
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<Figure 62> Magnetic Setting — Cell Group

There is the list of current fields in the sub-menu of “Input Field”. The selected cells are defined the

area of selected field as you select one of the fields.
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<Figure 63> Magnetic Setting - Input

To cancel the link, click right button for pop up menu, and click “Cancel Setup” or select cell and click

“‘Delete” key.

To encode in Bit mode, set the track as Bit mode. If the track is set to Bit mode, the track information
of previous normal status is back-up and input field is changed to Bit mode field. In Bit mode, the user
can input data as Hex-Decimal String and the field can be connected to “Input Field” and the data in

Input field should be written as Hex-Decimal string, as well.
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<Figure 64> Magnetic Setting — Cell Group

This can be also applied to the other magnetic tracks.
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4.2 Continuous issuing (Mass issuing)

4.2.1Usage
This function is used for mass issuing like membership cards, student ID cards and national ID
cards, etc.
@ Design basic cards form with Smart Design — @ Change name, picture, number, etc. —
® Check each cards information is correct — @ Start to mass printing
* You can import from or export to the Microsoft Excel, Microsoft Access and ODBC by using
Smart DB. Please refer to the Smart DB User Manual.

4.2 .2Field creation, add, delete

At first, design the card what you want to print with Smart Design.
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<Figure 65> Document for Mass Issuing
Click : Ribbon bar - Option tab = “Input field Setting”

Input field management window appears.
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<Figure 66> Input Field Setting
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To set input field name, open input field at first and enter the field name. Field name is
capital letters always. After creating field name, double click the next column. In default

Value column, enter subject, then click “Close” button. You have set basic field name.

After field is created, field and object should be linked. All objects such as text, image,
barcode and magnetic track are available to link with field. Select a field in the field list and
an object on the screen. Click “Connect field” to make connection between the field and the

object. Then, the default value of the field is applied to the object.
Fields linked with text object and barcode object cannot be linked to image object. Because
there should be image file name in the image objects. For the same reason, fields linked

with image objects cannot be linked with text or barcode objects.

When image object is linked to field, “File Search” button is created in the default value

column. Double click to enter the whole file path or click “Search” button to select image file.

Click “Disconnect” to disconnect link between field and objects.

To delete or edit field, select the field and click right button. Two options will be shown.

Setup Input Field ®
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| elete Fiel
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<Figure 67> Delete or Revise Input Field
Click “Delete Field” to remove all link information about the selected field.
Click “Edit Field” to change the value of the field. You can make activate a cell just double

click to the cell what you want to change.

Click “Print” to print directly from this menu.
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